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Before you start ...

About This Documentation

This documentation applies to version 2018 of the Prinect DFE (Digital Front End).

Prinect DFE is a prepress workflow system fully based on the Job Definition Format (JDF). Prinect
DFE is a component of the Heidelberg Prinect product range.

This documentation provides you with an overview of Prinect DFE. Furthermore, an example is used
to illustrate how a typical process is set up and run.

What you should already know

We assume that you are familiar with the Windows® and Mac 0S X° operating systems that are sup-
ported by this application. You should also be familiar with the processes and terms used in a digital
print shop workflow.

Further Documentation

You can find more information in the following documentation:
+ in the enclosed "How to get started" leaflet

« in Heidelberg Prinect Licensing - User's Guide

« in the Online Help for the Prinect Cockpit
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Before you start ...

Symbols and Styles

The following typographical conventions are used in this manual:

- References to other chapters and sections are blue (on the screen) and underlined.

Example: See section "Symbols and Styles", page 6.

+ Quotation marks are used to indicate menus, folders, functions, hardware conditions, switch
settings, system messages, etc.

Example: Set the switch to "off".
+ Menus, functions and sub-functions are separated by ">".
Example: Select "File > Open...".
« A plus sign is used to indicate that several keys have to be pressed at the same time.

Example: Press Alt+A.

Important Information

Important information in the text is indicated by symbols at the side which are used as follows:

Warning: Contains information that must be taken into consideration to protect the user
A from injury.

Caution: Contains information that must be taken into consideration to prevent damage to
hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be fulfilled before the steps which follow can
\/ be performed.
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Basic Concept of Prinect DFE

Prinect DFE provides functionalities for an automated Prinect workflow for output on Heidelberg or
Gallus digital presses. This workflow spans steps ranging from preparation of the digital job data to
output of the production run at the digital press and finishing of the printed products.

What are the Components of a Prinect DFE?

Prinect DFE is built up on the model of a server-client architecture. The core of the system consists

of a central database and components that control all the processes in the system and that regulate

communication flow between the single components. Important basic data like for example, printing
materials, user or customer data, color profiles, are stored in the MDS (Master Data Store). Job pro-
cessing is done by "engines".

The user interface of the Prinect DFE is the "Cockpit" that can be installed as a client application on
several computers in the network environment.
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DFE server PC Additional Cockpit work-
station
Prinect Cockpit Prinect Cockpit
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vices, Master Data
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rer

Prinect Color Toolbox

How Do | Use Prinect DFE?

The "Cockpit" is the central user interface for all work that a user does on Prinect DFE. You can install
this program in a Windows and in a Mac OS X operating system environment. You can perform the
following tasks in the Cockpit:

- Edit basic system settings (create users and customers, enter spot colors, etc.)
-+ Configure processing steps for automated job processing and

- create jobs, compile job components (input files, sheet layouts), view and monitor jobs, submit
jobs or job data for processing or for approval, check the job status.

A licensed, if possible latest, version of the Adobe Acrobat Professional software should be installed
on each workstation using the Prinect Cockpit. This software is not included in the shipment of the
Heidelberg Prinect software. The operator of the Prinect software is responsible for seeing to it that
Acrobat Professional is installed on each Cockpit computer before installing the Cockpit.
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How Does Licensing Work?

Each installation of the Prinect DFE software includes installation of all the software components,
irrespective of the licenses purchased. The number of options that you can use on a permanent basis
is controlled by a license key. The "Prinect Licensing" module controls the enabling of the options and
administration of the licenses. Prinect Licensing consists of two software components, the License
Server and the License Manager. The licenses are enabled online via the Heidelberg Trust Center or
locally by a dongle (USB stick).

Online licensing is based on an online protection certificate that is enabled during installation of the
software. For this purpose, before installation of the Prinect DFE software, an installation code is
required that triggers activation. The certificate is connected to real or virtual hardware and is auto-
matically renewed daily. If the Internet connection to the Heidelberg Trust Center should fail tempo-
rarily, the existing certificate continues to be valid for 30 days. Administration of online licensing is
through the Prinect Maintenance Center and the Prinect License Manager.

The License Server and the License Manager interact in a "client-server architecture". Administration
of the licenses is done in the License Server whereas the License Manager depicts the user interface.
The License Server (perhaps plus dongle) is usually installed on the Prinect DFE server. In bigger sys-
tem environments with a number of Prinect servers, it may be advisable to set up a dedicated License
Server PC.

Note: You can find details about licensing in the "Heidelberg Prinect Licensing — User's
Guide".

Sequence Templates

In the Cockpit, the processing operations are configured as "sequence templates" that are to run in
the output workflow. Sequence templates contain all the key settings that are required for correct
printing. These templates only have to be set up once and after that they can be used for any number
of print jobs that need the same setup. For that reason, it is generally enough to enter a few basic
data when creating a new print job and to select the matching sequence templates or a group tem-
plate. See "Group Templates", page 10. All the output parameters are predefined in the sequence
templates and do not need to be reconfigured.

Basic sequence templates

The most important sequences are "Qualify" and "PagePrint". Other types of sequences are available
for advanced workflow options, depending on the licensing options you have.

- In the Qualify sequence, the input documents are converted in a "Normalizing" step to a
cleansed PDF format suitable for the subsequent processes. In a "Preflight" step, the input doc-
uments can be checked, for example, for the presence of all required fonts, correct image reso-
lution, use of transparency elements, etc. You can customize the preflight settings to suit your
needs.

- In a PagePrint sequence, output to a digital press is configured. In this case, the majority of the
print parameters are defined interactively during job processing.

Prinect DFE - User’s Guide 9
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Group Templates

To configure automated processing, you can group several sequence templates to "group templates”.
In a group template, you can link single sequences by drawing connecting lines between them. These
kind of linked sequence templates can run automatically one after the other without intervention
from the user. You can save different processing setups as different group templates.
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Job Processing Workflow

The graphic below shows you a diagram of the basic workflow in processing job files in the Prinect
DFE workflow:

—

PDF
file
are generated as PDF or PDF/VT files.

=

TP
file

Files from a customer or from
an editorial department

Preparation (Qualify) * PagePrint * Digital Printing Terminal
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1. A new job is created in the Prinect Cockpit when the input files are on hand. If you expect a
number of print jobs for a certain customer, you can create a job group where you can group the
jobs of this customer. Furthermore, it is advisable to enter the customer data (name, contact,
etc.) into the Prinect customer administration and assign the new job to the customer.

2. When you create a new print job, you can at this stage assign "sequence templates" or a group
template to the job.

3. A print job opens in the Cockpit after it is created. You can now check its settings and, if neces-
sary, change them. For example, you can modify single sequence templates or configure color
settings (color order, handling of spot colors, etc.).

4. After that, the job files are added to the job. You can define a job as "started" when you are cre-
ating it. In this case, the job files are processed straight away, usually with a Qualify sequence
which contains a preflight step that checks the files for possible errors (missing fonts, image res-
olutions too low, etc.).

5. Alternatively, you can also define job templates for creating new print jobs automatically. In this
case, you only have to drag-and-drop the PDF files you wish to output to a hotfolder. In this pro-
cess, a new job with the defaults of the job template is created automatically (section
"Automatic Creation of New Jobs using Drag-and-Drop", page 53).

6. Each of the pages must be imposed for output to a digital press. This is done interactively in the
"Digital Printing" step. Generally, this controls the whole print run, including finishing.

7. When the "Digital Printing" step is completed, the print jobs are submitted to the Digital Printing
Terminal (part of the Prinect Cockpit). You can use the Digital Printing Terminal in two modes:

- In the automatic mode; the print jobs are submitted automatically to the digital press.
- In the manual mode; the operator controls the order of printing.

8. The print jobs arrive at the digital press from the Digital Printing Terminal and are output on the
press.

Set up Customers

In daily work with the Prinect DFE workflow, the edited jobs are normally assigned to the customers
concerned. For this purpose, Prinect DFE has its own customer administration. Customer data are
filed in the Master Data Store and are available at various points in the Prinect environment.

Note: Details about customer administration can be found in the Online Help of the Prinect
Cockpit.

For example, you set up a "virtual customer" to be able to assign a customer to the demo jobs.

1. Go to "Administration" and click "Customers" (1).

12 Version 2018



Settings

T B

System Preferences

B

Customers lan E-mail

'ﬂ’;', Create Customer

Sector: Business
MName: HD Printshop
Customer |D: 0oa1
Mickname:

Person

Enter the following customer data:

- Sector: Business
- Name: HD Printshop
- Customer ID: 0001

- Nickname: HDP

3. Click "Open" beside "Person". The "Create Person" dialog opens:

Prinect DFE - User’s Guide
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%% Create Person >

Person
Title: fufr

First Mame: Peter
Family Mame: Bauer
Mame Surfix:

Additional Mame:

Job Title:

Channels

Cancel

Enter the following personal details:
- Title: Mr.
- First Name: Peter
- Family Name: Bauer
- Nickname Pete
- Language: German

These details about the contact are enough for our purposes. In "Communication Channels",
you can enter data such as phone number, mobile number, e-mail address, fax number or Web
address.

Confirm the "Create Person" dialog with "OK".
Then confirm the "Create Customer" dialog also with "OK".

4. The "Customers" window now displays your new customer at the top left of the customer list.
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3 Prinect Cockpit [Digital] - [AKIE-CE/PNDPMPTCanfighSysCorfi - Administrator]

Fle | Edit | View | Tools | Help |

B O &

% B/23471:24 PM There are

Mark your customer and fill out the "Address" section.
- Street: HauptstraBe 1
- Postal Code: 10111
- City: Berlin
- Region: Berlin
- Country Code: DE
- Country: Germany

5. Confirm your inputs with "Save". Close the "Customers" window by clicking "Overview".

Create a Job

All the elements involved in the processing of documents are combined to form "jobs". You are
prompted to enter the following information when creating a new job:

+ Basic job data
- Job Number

You must assign a job number to each job. A job number generally consists of a number
of letters and/or digits. The job number identifies each job in the DFE system. For that
reason, each job must have a unique job number. This is checked when you enter a new
job number. If the job number you entered already exists, the number displayed is red
and you cannot enter any more data until you enter a job number that is not yet used.
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- Job Name

The job name is the identifier that is used to display a job in the Cockpit user interface.
The job name, too, must also be unique in the system. This means that you must give
each job a job name that is not yet used as a job name in the system. After you enter the
job number, hit the Tab key. The job number is copied automatically to the "Job Name"
box. You can use the job number also as the job name or you can edit this entry.

- Documents

This is where you can assign document files to the job while you are creating a job. To
do this, click "Browse" and select the document files in the file system. You can also skip
this step and add the document files later after the job is created and opened.

- Job Group

Generally, it is advisable to create each job in its own job group. This lets you use a sep-
arate group, for example, for each customer you have or you create a "pool group" for
single jobs of various customers. A group structure that already exists in the system is
entered in this box. The group must be selected before you click "New Job". By clicking
"Change", you can select a different, available group or create a new group and select it.

- Job Home

In this box, you set the folder in which all the job-specific data in the file system will be
filed. Normally, the job files are filed in the "PTJobs" system folder (e.g. E:\PTJobs) of the
Prinect server and there in the "Jobs" subfolder. A subfolder with the name of the job
group is created in the "PTJobs" folder. A folder with the job name is created in this sub-
folder. All the job-specific data are filed in this folder. You must click the lock icon if you
do not wish to use this default. This releases the linking between job group and job folder
and you can use "Change" to select another folder for the job files. We recommend that
you do this only in exceptional cases because the defaults ensure that the job files can
be found fast in the system. The "PTJobs" folder is shared in the network, meaning that
the job files can be accessed by other computers in the system environment, for
example, by other Cockpit computers. In addition, the central location of all job files
facilitates a backup of the data.

« Customer Data

Assignment of customer data to a job is optional but we strongly recommend that you use the
Prinect customer administration (see section "Set up Customers", page 12) and assign customer
data to each job. In the "Customer Name" list box, select the customer name from customer
administration. The "Customer ID" and "Nickname" boxes are then filled automatically.

- Customer Job ID

The assigned Prinect job number is entered by default in this box. This is where you can
enter customer job numbers in the case that your customers use their own job numbers
that are different to the Prinect job numbers.
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- Customer Job Name

Similar to a customer job number, this is where you can enter a different customer job
name.

+ Processing

In this step, you can assign one or more sequence templates or group sequence templates to the
job with "Add". By doing this, you define how the job will be processed in the Prinect system.
You can still edit each of the steps set in the sequence templates after the job is created. This is
where you can save the selected sequences as a template for new jobs generated automatically
(see also chapter "Automatic Creation and Output of New Jobs using Drag-and-Drop", page 53).
You can skip this step for the time being and assign the required sequence templates later in the
open job.

+ Scheduling
In this step, you can enter details about the following scheduling data:
- Responsible

This is where the Prinect user who is responsible for processing the job is entered. By
default, this is the name of the user logged in to the Cockpit. Using "Select", you can
select a different name from the Prinect user administration. The user must have the
required permissions in the Prinect system.

- Set Due Date

You can select a date for the scheduled due date by clicking the calendar icon. This date
is for logging only and does not control the time printing will run.

- Job type

You can select one of the following job types in the list box: Production, Product, Prelim-
inary job, CAD (for packaging printing), Reuse, Job Template.

- Job Priority

You can assign a priority to each job. For example, this lets you set that very urgent jobs
are given a higher priority and are processed before other jobs.

- Pages

Generally, the job data or information from the customer tells you how many pages the
job has. Together with the planned amount, you can estimate how big a job will be.

- Delivery quantity
The delivery quantity indicates how many copies of each page will be printed.

The new job is created after you click "Finish" and opens immediately if this option is enabled.

Prinect DFE - User’s Guide 17
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Components of a job

A job contains a number of components that are set up or edited as "sections" or "steps". After the
job is set up, you start it and the steps are run one after the other.

A job contains the following sections or steps:

18

+ "Product Description” section

This is where data like delivery quantity and details about the customer for whom the job was
created are entered.

+ 'Processing' Section

This is where the processing sequences or group sequences are added to the job. You can edit
each of the sequence settings separately in this step.

- "Properties" Section

This is where other properties like delivery quantity, pages planned in a job, predecessor job
details or gang job details are recorded.

« "Colors" Section

The use of the process colors is configured in this step.

+ "Printing Process" Section

This is where parameters relating to the printing process (e.g. print order, input/output profile)
are displayed or configured.

+ "Documents" Step

Document (PDF files) are added to the job in this step.

- "Pages" Step

Page lists are defined in this step and the document pages are assigned to the page list place-
holders.

« "Digital Printing" Step

In the "Digital Printing" step, pages are imposed interactively and you set output and finishing
options. Furthermore, this step has options for examining the imposed sheets in detail (magni-
fier function, etc.) and you can, for example, view a preview of a finished booklet in which you
can also scroll through.

- "History" Section

List of the actions performed throughout the job.
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Configure Sequence Templates

able, a suitable digital press must be set up in the Prinect system. In addition to installation
of the press, the machine must be set up in the Prinect Cockpit in "Administration > System
> CDM". You will find details about the connection of digital presses in the Online Help of
the Prinect Cockpit in "Connecting Machines > Connecting Digital Presses".

Prerequisite: In order for the "PagePrint" sequence needed for digital printing to be avail-

To configure the sequence templates needed for the examples below, proceed as follows:

1. Go to "Administration" and click "Templates".

Administration

Settings

Dynamic Marks

2. The "Templates" window opens. Click the folder icon beside "Sequence Templates" to display
the single sequence items.
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Configure a Qualify Sequence

Fle | Edit | View | Tools | Help |

HZID=LB=RG

,:' Templates

Criterion Machine Created on Created by Date Modified |/

New Folder... Open Delete Succession...

Malfunctions /0

1. Highlight the "Qualify" sequence type (1) and click "New" (2).

The setup section for a new Qualify sequence opens:

Overview 1' Templates

Untitied (Qualify)
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Set this sequence as follows:

2. Leave "Normalizing", "Split Document" and "Destination" disabled or as they are.
Enable "Hotfolder" and leave the defaults as they are.

Enable the "Preflight" option and display the parameters by clicking the small triangle before the
checkbox.

5. Click "Browse" in the "Heidelberg Preflight Profile" section of the "Actions" tab. Select the
"CMYKDefault.hpp" profile.

Heidelberg Pre

Browse... H

6. Click "Save as":
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5 Save Template >

O cualify

Template Man

Comment:

CustomerD: nnon1 Edit...

Froduct Codes: Edit...

Froduct Types: Edit...

Cancel New Folder... Delete

7. Type in "Qualify_HDCity" as the name and select "HD Printshop" as the customer with "Edit" in
"Customer ID". Confirm the "Save Template" dialog with "OK".

8. Click "Close". The sequence overview displays.

Configure a PagePrint Sequence

Prerequisite: A "PagePrint" sequence is available only if a digital press is connected to and
set up on Prinect DFE.

In the "Templates" view, highlight "PagePrint" in "Sequence Templates" and click "New".
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"Accept approved pages only" Option

This option is designed for an "approval workflow". When this option is enabled, only PDF pages with
an "approved" status will be processed. You will find more details about the approval workflow in the
Online Help of the Cockpit. We will leave this option disabled.

"AutolmposePDF" Option

This option is always enabled and cannot be used.

"Digital Printing" Step

In this step, you can set up parameters for paper, pages, layout, print marks, print and finishing as
well as color settings of the press and save them as a template.

Configuration of paper and page settings

1. Go to "Digital Printing" and in the "Paper and page settings" tab set, for example, an A3 paper
as the paper:

The paper grades are set up at the press and these data are sent to the Prinect Cockpit. If
required, you can select a different paper grade from the "Paper" list box. If you change the
paper size, the new size displays at once in the preview pane.

2. Some digital presses (e.g. Heidelberg Versafire CV, CP) give you the option of printing the cover
pages (the first and last two pages of the PDF document) on different paper. In the example, the
cover pages are to be printed on the same paper as the content pages.

Note: In the page preview, the cover pages are highlighted by a dark yellow label.
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3. Leave "Non-printing Margin" disabled. This can be a good idea for some jobs, for example,
where logos or business cards are not to be printed right up to the edge of the paper.

4. Leave "Subject Offset (manual)" disabled.

. Note: This option lets you manually set the horizontal and vertical spacing between the sin-
gle subjects on the printing material. You can use this, for example, for printing labels.

5. In "Imposition Trimmed Size" leave "From PDF" as it is. Leave "Page Policies" as "Fit to Size".
"Expected Orientation" is set to "Portrait" and cannot be changed if "From PDF" is set.

6. Inthe "Bleed and Trim Allowance" section enter 3.0 mm in the "Bleed" box . Then hit the Tab
key. The new value is applied to the preview. Set "Trim Allowance" to "Automatic”.

Configuration of the layout settings

Press Sheet Layout
Autolrrange Folding Sheets 3

Columns | 1 Repeat

Rows 1 Repeat

4 Creeping

5 Back Margin 1.0

Gripper for Saddlestitcher (Collator)

: Mone :

f—

Go to the "Layout settings" tab and select the "booklet layout" (1).
2. Select "Saddle Stitch" in the “Binding" list box (2).

3. Enable "AutoArrange Folding Sheets" (3).

4. Enter a value of 0.1 mm in "Creeping" (4).

5. Enter a value of 1.0 mm in "Back Margin" (5).

Leave all other settings as they are.
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of the Cockpit (F1 key).

Configuration of the print mark settings

[] Folding Sheet Cuts
[] cut Marks
[] Fold Marks

|:| Lay Marks
[] color Bar Offset

Y4
|:| Register Marks 0.0

On side hd

[] conlating Mark

Automatic b d

[] info Text

i
0106
0106
0108

0106

—» |+
0106

Introduction

. Note: Use the "custom layout scheme" button (6) to open a Layout Scheme Editor where
l you can create a custom layout scheme. You can find details about this in the Online Help

1. Go to the "Print mark settings" tab. Because no print marks will be used in this example, leave

all the options disabled or disable any checked options.

Prinect DFE - User’s Guide
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Configuration of the color settings

R = & o

™ ¥ Source Profiles

m Enakle anagement
D Use Embeddec Profiles
If no profile known

IS0
Rl | Relative colorimetric -

Keep CMYK Colors
Off

E] Use Embecdec Profiles
If no profile known

HOM sRGE Profile.icm

Rl | Perceptual ¥ BPC |:|

V' » KeepBlack
g&# P Spot Colors

B ) output Profile

1. Go to the "Color settings" tab and open "Source Profiles".
2. Leave "Enable CMYK Color Management" and "Use Embedded Profiles" enabled.

1

3. If needed, you can customize the "Keep Black", "Spot Colors" and "Output Profile" sections by
clicking the respective triangles. These settings are not changed in our example. Details about

these parameters can be found in the Online Help of the Prinect Cockpit.

26
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Configuration of print and finishing settings

—_

Go to the "Print and finishing settings" tab.
Leave the "User-defined" option enabled.
Set "Face Down" in "Output Delivery" (1).
Set "Sort" to "On" (2).

ok wDn

Set "Interposer upper tray" in "Separator sheet" (3) (the options you can select depend on the
setup of the digital press).

In "Image Shift" (4), leave the values as they are at "0.0".
7. In "Print Options", leave the value for screening as it is at 200 dots (1200 dpi) (5).

8. Afigure of the finisher installed at the digital press displays in the graphic (6). If necessary, select
a different finisher matching your setup by scrolling forwards or backwards with the arrows.

9. Set the other finisher settings to suit your needs. These finishing options depend on the installed
finisher.

Save sequence template

10. Click "Save as", assign "HD Printshop" as the customer and save the sequence template as
"PagePrint_HDCity". Close the window with "Close".
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Create a Group Template

For the processing of a job it is not absolutely necessary to create a group template but the use of
group templates facilitates the processing of further print jobs that need similar processing steps. A
group template will be created to illustrate how you define and use a group template.

1. In "Administration > Templates", mark "Group Templates" in the sequence overview and click
"NeW“‘

The empty setup window of a group template opens.

File | Edit | View | Tools | Help |

B O &

SIDELB=RG

Overview

Add Template

Save as... Close

2. Open the "Qualify" folder and select "Qualify_HDCity" (1).
3. Then click "Add Template" (2).

An icon for the Qualify sequence is created in the workspace.

4. Repeat steps 2 and 3 also for the "PagePrint_HDCity" sequence. The workspace now displays as
follows:
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1' Templates

Add Template

Delete Save Save as...

5. In the workspace, select "AutoArrange" in the context-sensitive menu. The icons are placed side
by side and aligned.

6. Save the group template as "HDCity_Group_Template" using "Save as".

3 Save Ternplate et

Template Ma

Comment:

Cancel New Folder... Delete
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7. Close the group template and quit the "Templates" window by clicking "Overview".

All the sequence templates needed for a basic workflow are now configured.

Configure the Digital Printing Terminal

The Digital Printing Terminal is the link between the submitted Prinect print job and the digital press.
You will find details about the prerequisites and operation of the Digital Printing Terminal in the
Online Help of the Prinect Cockpit (1).

You can configure the Digital Printing Terminal for two modes:

- for the manual output mode or
- for the automatic output mode.

In the manual output mode, you can customize which print jobs will be sent in which order to the
press.

In the automatic output mode, the print jobs are submitted automatically to the press in the order in
which they arrive at the Digital Printing Terminal.
You open the Digital Printing Terminal by clicking its button (1) in the section toggle.

HEIDELB=RG

= Mumbero.. 5 Prin

Automatic Output Mode: All new or . o
existing jobs are output You can start waiting or finished

print jobs from the job lists with

automatically.
"Start" or using drag-and-drop.

The automatic output mode is set by default after installation. You can switch to the manual output
mode by disabling "Automatic Output Mode" (2). The automatic output mode will stay enabled for the
workflow described in this documentation.
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- Note: The "Jobs" view also has a "Digital Printing Terminal" section. This view is designed
l to give you a fast overview of the progress of digital printing. However, you cannot control
printing from this view.

Automatic Workflow by Dragging-and-Dropping
Document Files

You can use the DFE for automated job processing where new print jobs are created automatically
when you drag-and-drop document PDFs in the job list of the Cockpit. In this process, it is enough to
save the required sequences as a template in a new print job. You can find details about this workflow
in the chapter "Automatic Creation and Output of New Jobs using Drag-and-Drop", page 53.

Automatic Workflow in the Hotfolder Mode

Another variant of automated job processing works using special folders called "hotfolders". A new
print job is created automatically whenever document files enter such a hotfolder. You can find
details about this workflow in the chapter "Automatic Creation and Output of Print Jobs in the
Hotfolder Mode", page 61.
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Manual Creation of a Print Job

This chapter shows you how to create a print job (example: "HDCity" booklet) manually and edit it up
to printing.

. Note: The examples shown in this documentation solely demonstrate operation and must
not be understood as imperative instructions.

Create and Edit a Job

After you prepared the sequences that are needed (see the section "Configure Sequence Templates",
page 19), all the prerequisites required for creating a new job are met.

. Prerequisite: All the prerequisites required for creating a print job in the Prinect DFE are

now listed once again below:

- Job file: HDCity.pdf in the example
- Customer: HD Printshop

- Sequence templates: "HDCity_Group_Template" with "Qualify_ HDCity" and "Page-
Print_HDCity" sequences.

Create a New Job

1. In the Prinect Cockpit, go to "Jobs" and click "New Job". The "Create new Job" dialog opens:
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File | Edit | Wiew | Job | Tools | Help |

SIDSELB=RG

= | £3 Job Group % Classic -

Job Number

~ Job Name ¥ JobStatus 5 JobFlags ¥ |Prom

Change...

Change...

<< Back Next >> Finish Cancel

2. This dialog has four views that you can go between with "Next" or "Back". First fill out the boxes

in the '

'Basic job data" view.

- Assign a job number. You can take the job number, for example, from the job ticket of a

customer job. Job numbers must be unique in the Prinect DFE system environment. This
means that each job number can be assigned only once. In this example, we will assign
"HDOO0O1" as the job number.

- Your next step is to assign a job name. Job names as well must be unique. When you go

to the "Job Name" box, the job number is copied automatically to this box. You can use
the job number as a prefix for the job name or overwrite it. We will assign "HDOOO1_H-
DCity" as the job name.

- In the "Documents" box you can now assign the documents (supplied by the customer)

to the job. You can also do this step later in the created job. We will not assign any doc-
uments at this point.

- By default, "Job Group" and "Job Home" are linked. This means that if you define a new

34

job group, a folder of the same name will be created automatically for this job group. We
want to create a new job group and click "Change". The "Select Group" dialog opens:
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¥ Select Group *

Select Group

« Click the plus sign beside "PRJOBS". Another edit box dis-
plays.

+ We will assign "MyPrintshop" as the group name and click
"OK". The "Select Group" dialog closes.

3. Enable the "Start Job" option. Leave "Maximize Job View" disabled.

4. Click "Next" to open the "Customer Data" view:
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5.

36

%% Create new Job >

Basic job data ner Data Frocessing Scheduling

fou can n a customer to the job.

Customer Name:

Customer ID: o001

Mickname: HOP

CustomerdJob D: HOoo1

CustomerJob Mame: |HDOOO1_HDCity

=< Back

Select "HD_Printshop"” in the "Customer Name" list box. This item is taken from customer
administration of Prinect DFE. "Customer ID" and "Nickname" are also taken from there. "Cus-
tomer Job ID" and "Customer Job Name" are copied from the basic job data you defined before-
hand. You can overwrite these items if you have other customer job data that differ from the job
data set in the Prinect system. We will leave these items as they are.

Click "Next" to open the "Processing” view: In this view, you can add prepared sequence tem-
plates to the job. Click "Add". The "Select Templates to Add" dialog opens:

'33', Select Ternplates to Add Y

Cancel
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7. Select "HDCity_Group_Template" and click "OK". The group template contains all the sequence
templates needed for processing this job.

M Note: You could also add Qualify and PagePrint as separate sequence templates. In this
case, the same functionality would be available.

¥ Create new Jab >

P——9—=_
E Basic job data Customer Data Processing Scheduling
III
You can assign sequence templates or group templates to the job.

[ HDCity_Group_Templlate

<= Back Next ==

8. Enable "Save as default”. As a result, the "HDCity_Group_Template" will be assigned automati-
cally to all new print jobs. If required, you can undo this assigned template by marking the group
template and clicking "Remove" and then assign other sequence templates. In addition, the
group template is enabled for automated job processing (see chapter "Automatic Creation and
Output of New Jobs using Drag-and-Drop" and chapter "Automatic Creation and Output of Print
Jobs in the Hotfolder Mode"). Click "Next". The "Scheduling" view opens. In this view, you can
select the person responsible, enter a due date, set the job type and assign a priority. Leave
these settings as they are. Enter "36" in the "Planned Pages" box. Enter "5000" in the "Planned
Amount” box.
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%% Create new Job >

You can define settings for job planning.

Responsible: Administratar Select...

[ setDue Date:

Job type: Production
Job Priority: Mormal
Fages:

Delivery quantity:

9. All the data needed for creating the new job are now entered. Click "Finish".

The new job is created and opens in the "Job" window. Double-click the caption bar of the "Job" win-
dow to maximize the width of the window. The view in which a job was last open displays at first. You
can switch the job view at any time.

Edit a New Job

After you created the new job, you must run some steps in the open job.

Add documents

1. Go to the "Documents” step. In this step, the document files that will be edited and finally
printed are copied to the Prinect workflow.
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Drag-and-drop documents to this area or use the function "Add Files".

2. To add the document PDF files to the job, you can either drag-and-drop the files from the file
system (Windows Explorer, Macintosh Finder) to the window (1) or you can open a file selection
dialog with the "Add Files" button (2).

3. Click "Add Files". The "Add Files" dialog first displays the content of the "PTConfig" folder on the
Prinect server.

4. In the "Look in" list box, go to the "PTDocs" folder of the Prinect server. Then open the "Test-
jobs\HDCity\PDF" folder (this job is an example; you can also use other suitable PDF files here).

E Add Files *
Prinect Meighborhood  Computer: | KIE PHOFPM =
Look in: = PDF - o 421

Name = ~ | Modified ~ | Attributes

0

File name: HD_ City.pdf

Files of Type: | Page Formats (eps, .pdf, jpeg, jpa, tiff, zip, tif, ps)

» Advanced Options
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5. Highlight the "HDCity" PDF file and click "OK".

Add documents using drag-and-drop

As an alternative to the "Add" button, you can also add PDF documents to the "Documents” step by
dragging-and-dropping them from a Windows Explorer window (or Macintosh Finder window):

1. In addition to the Prinect Cockpit, open the Windows Explorer and go to the folder where the
files you want are located.

2. Inthe example mark "HDCity.pdf", drag it holding down the left mouse button to the "Docu-
ments" area in the open job or to the "Documents” icon and let go of the mouse button. Adding
documents using drag-and-drop to the step icon works even if the step is not open at that
moment.
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Because the job was activated before you added the files, the PDF documents are processed imme-
diately by the "Qualify_HDCity" sequence. After processing is finished, the documents will have
"Completed" as their status.

Edit colors

In this step, you will check whether the documents you added have spot colors. Spot colors are
replaced by CMYK process colors for digital printing. Normally, the PDF files contain the "recipes" for
spot color replacement. In our example, we will show how you can define or modify a spot color
replacement in the job settings.

1. Click the small arrow in the top left icon (1) and select "Colors".

The colors found in the loaded documents display in this view. For example, in the "HDCity"
booklet, "Pantone 281 CV_cmyk" displays as a spot color in addition to the CMYK process colors:
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2. The CMYK substitute values for this spot color display in the relevant table column. These values
were already in the PDF files. You can overwrite the values for C, M, Y and K if you wish to
change this "color recipe”. The result displays immediately in the spot color patch.

After your input, the information in the "Source" column switches automatically from "PDF" to
"Job". This indicates that spot color replacement for this color no longer uses the definition in

the PDF document but that it was modified as a "job setting" and is applied in this form to the
current print job. You can create a new spot color with the "New Color" button. You can import
spot colors available in Prinect DFE to the job with "Import Colors". Confirm changes to the set-
tings with "Save".

3. Inour example, leave the default settings as they are.

Set up and output digital printing

. Note: You can find details about these options in the Online Help of the Prinect Cockpit >
"Digital Printing Step" (invoke with the F1 key).

Go to the "Digital Printing" step. In this step, you can interactively impose (PDF) documents on a (dig-
ital) press sheet, set delivery and finishing options as well as configure the color settings of the press
and submit the imposed press sheet for output.
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The window structure is as follows:

- The left part of the window (1) is where the single pages display.

- The preview pane (2) shows a preview of the sheet layout. The appearance of the sheet layout
depends on the imposition parameters configured in the right-hand area of the window. You can
choose between different views and use various tools to see detailed information about the
pages shown.

+ You can set all the parameters that are required for imposing the pages on the printing material
and for setting up the press (display, finishing) in the various tabs in the setup pane (3):

- "Paper and page settings",

- "Layout settings"”,

- "Print mark settings",

- "Color settings" and

- "Print and finishing settings".

The basic output parameters were already set up in the settings of the loaded "PagePrint_ HDC-
ity" sequence template (see section "Configure a PagePrint Sequence”, page 22). You can modify
the output parameters if required. These settings affect the open job.

Color settings

In the "Color Settings" tab, you can define settings for spot color replacement that cannot be set by
default in a PagePrint sequence:
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e (0 3

HDOOO1_HDCity Number: HDOOO1 G o} » e B B0

(>>

—
Peers s &
Documents. Pages Digital Printing

1 Spot Color Matching...

b output profile

FB0O01 Front

In "Spot Colors" you can configure custom settings for replacing spot colors in the current job by
clicking "Spot Color Matching” (1).

- Note: The settings always relate to a specific paper grade on a specific press. These settings
1 always affect all digital print jobs until you change these settings again.

The "Spot Color Matching" dialog opens:

I Spot Calor Matching X

Color Name PAMNTOMN
Original Color

Selected Color

Settings
Step Witdth
Correction Lightn

Paper Grade unc

Output Device Y 7

Tagaed patches cannot be output carrectly on
paper.

AEee: 0.42

Print Test Page
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In the "Color Name" list box, first select the spot color for which you want to define a substitute
color. All the spot colors that are in the current print job are listed.

The original color displays in the middle color patch "C4" in the preview window. Modified colors
display around the original color. Colors that cannot be output correctly to the paper set in the
print job are marked by an "x".

The aim of these settings is to determine a color that can be output correctly, in other words, a
color that is not marked by an "x".

Click "Print Test Page". A test chart is printed.

print jobs are set up with the color settings that are required for a true-color output.

Note: Each test chart printout creates a new separate print job in the DFE. These test chart

8.

Now compare the printout of the test chart with the original copy and determine the color patch
that best matches the original spot color.

If the deviation is still too big, enable either "Lightness/Chroma" or "Color Cast" in
"Correction" to set the type of color change. Now move the "Step width" slider until suitable
patches display in the preview window. The larger the step width, the greater the differences
between each of the color patches.

Repeat steps 2, 3 and 4 until you are satisfied that the target color is determined accurately
enough. On the test chart, the patch with the correct color has an "address"”, e.g. "B 2".

Click the "B 2" patch in the "Spot Color Matching" dialog.

The CMYK values of the original color display in "Original Color". The values of the selected
color display accordingly in "Selected Color" (in our example, those of "B 2").

Note: If you wish, you can manually set the color of the marked color patch by entering
CMYK color values in "Selected Color". If Heidelberg inkjet digital presses (Labelfire, Prime-
fire) are used, L*a*b* values display in this case. You cannot edit these values (Multicolor
color space).

Enable "Edit alternate color in job colors” if you wish to set the alternate color only for the
current print job.

If the alternate color is to be set always for the paper grade used, enable "Use alternate color
always for selected paper grade "..." on (...)" and select the paper grade in the list box. Then
these settings affect all print jobs that are printed with this paper grade on this press. This setup
is applicable until you edit it again.

If you are satisfied with the colors selected, confirm the dialog with "Apply".

Use the "Reset" button to reset all the settings so that special spot color settings are no longer
defined for the particular paper grade/press combination.

The "Paper Grade" and "Output Device" boxes are for your information only.
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Editing options in the preview pane

= Note: You can find details about these options in the Online Help of the Prinect Cockpit >
"Digital Printing" step (invoke with the F1 key).

In the preview pane, different view and check options are available:

- Toggle the view mode between sheet, layout, separations, area coverage and reader's spread.
+ You can use the hand tool to move the image content of the preview.

+ You can measure dimensions with the dimensioning tool.

- Use the zoom tool to set the display scale of the preview.

+ Use the magnifying glass tool to zoom in on a section of an image like a magnifying glass.

+ The info tool provides detailed information about a specific part of the preview.

+ The "Color Matching" function function lets you customize color reproduction in digital printing.

"Color Matching" function

Sometimes it is necessary to fine-tune color reproduction in digital printing just before printing, based
on what you see on the screen. The "Color Matching" function lets you define such color settings
based on a master page taken from the current print job. These settings only affect the print job that
is currently being edited.

. Prerequisite: The screen used should be calibrated for this functionality.

the preview window, mark a page that contains one or more image objects that are suitable
for evaluating color matching.

2. Click "Color Matching". The "Color Matching" dialog opens:
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¥ Calor Matching X

Lightness

Contrast

I _'nI.II.I.I.I.I.

-

Highlights i

[

]

Chroma

Blue-Yellow =
Green-Red =

’
) [E)iz) )z [0 o o

-

3. In this dialog, you can adjust gradation parameters "Brightness”, "Contrast”, "Highlights"
and "Shadows". You can check these parameters in a gradation curve in addition to the pre-
view.

4. Apart from these, you can also set color parameters "Chroma", "Blue-Yellow" weighting and
"Green-Red" weighting. You can review these settings in the page preview.

5. You can set the gradation and color data either using the sliders or by entering values.
6. There are seven buttons in the lower left part of the "Color Matching" window:

Use the five left buttons to alter the separating line between the original and the customized
area of the image preview. You can choose between the following settings:

- No separating line (the whole preview window shows the customized color data)
- Horizontal separating line, the preview is split horizontally
- Horizontal separating line, the preview is duplicated

- Vertical separating line, the preview is split vertically
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- Vertical separating line, the preview is duplicated
You can use the two right buttons to scale up or down the preview.
7. The "Reset" button lets you reset all the settings to their original values.

8. Click "OK" to apply the settings to the whole print job and close the "Color Matching" window.

Save settings as a PagePrint sequence template

If you changed output parameters, you can save the new settings as a PagePrint sequence template.
You can then use this template for other print jobs. In the case of the current print job, you do not
have to save the settings as a separate step. They are automatically saved with the print job.

*PagePrint_HDCity

p Source Profiles

1. The currently active PagePrint sequence displays above the parameter tabs. In our example, this
is "PagePrint_HDCity" (1).

2. Click the "Save Template" button (2). The "Save Template" dialog opens:

48 Version 2018



Manual Creation of a Print Job

¥ Save Template >

O PagePrint_HDCity

Template Mar

Comment:

Cancel New Folder... Delete

3. This is where you can assign a new name. The settings are then saved as a new PagePrint
sequence template. If you do not wish to change the name of the sequence, the existing "Page-
Print_HDCity" sequence is overwritten with the new settings.

4. Confirm the dialog with "OK". Confirm the alert message that appears also with "OK".
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Printing
1. To check your print and finishing settings, go to the "Print and finishing settings" tab. Define your
setup as required.

2. Click "Submit" (1) to start printing.

"
$ 7 s

FB001 Front

The "Submit" dialog opens:

B Submit X

Output

® Mormal

() Test Print
] .

Print Range

= Al

Priority | Mormal |=
»  Output Options
» Details

»  Scheduling

Cancel

3. Inthis dialog, you can still assign a priority, correct the delivery quantity, set front and back
properties, assign a work type, enter a comment and set the time for printing.
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(4). Enable the "Test Print" option (1) if you wish to output the job as a test print to check the qual-
ity of the color, for example. Activation of this option has the following impacts:

- The delivery quantity is automatically set to "1" because usually you need only one copy
as a test print. You can increase the delivery quantity manually, if required.

- The work type is set to "Internal”.

- The parameters in the "Scheduling" section are disabled.

- After output, a test print is not tagged as "finished".

If the job is to be output normally after the test print, all you have to do is submit it again and
disable "Test Print". The parameters set beforehand in the "Submit Elements" dialog are enabled

again.

5. The print job is submitted to the Digital Printing Terminal when you confirm this dialog with
"OK". In this sample configuration, the print job is submitted directly to the press because the
automatic output mode is enabled in the Digital Printing Terminal (see section "Configure the
Digital Printing Terminal", page 30).

6. After output, you can close the print job.
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Automatic Creation of New Jobs using Drag-and-
Drop

The Prinect DFE lets you use a predefined print job as a template for other print jobs and outputs.

You only have to drag-and-drop the PDF documents you wish to output from Windows Explorer (or
Macintosh Finder) to the relevant job in the job list of the Cockpit. This process will be described in
more detail below.

Prerequisites for the Drag-and-Drop Mode

For this workflow, some prerequisites must be met on the Prinect DFE computer so that automated
job processing works smoothly.

. Prerequisite: The following requirements must be met for output with a reusable print job:

- A print job for digital printing must be defined and it must have all the required matching
settings (sequences, imposition and finishing parameters).

- The print job condition must be "Idle" and the processing status must be "OK". The print
job must be closed before output and it must be seen in the Cockpit job list.

- The sequences required must have been assigned to the print job as a template, either
separately or as a group sequence. This ensures the automated processing of printing.

- The documents to be output must be able to be edited without an error and their page
size must match the imposition settings in the PagePrint sequence. The number of pages
does not have to match the page total defined originally in the PagePrint sequence. It will
be matched automatically during output.

Prepare a Print Job

We will use the "HDOOO1_HDCity" booklet print job as our basis, like in chapter "Manual Creation of
a Print Job".

After the "HD0O0OO1_HDCity" job was configured and used successfully for output of the "HDCity.pdf"
document, you will now create a similar job for automated output.
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Fle | Edit | View | Job | Tools | He |
=)
b 5 &
e L]]
o)
+|-Job Name +|JobStatus | Jobm

HDO0O1_HDGity > idle

1. Go to "Jobs", mark the "MyPrintshop" group and click "New Job".

2. Fill out the "Basic job data" view as follows:

'3:’:,', Create new Joh
b—8—— @

Basic job data Customer Data Frocessing

Jokb Mumber: | H

Job Mame:

Documents:

Joh Group: /PRJIOCBESMyPrintshop

Job Home: UIE-CEVPHDPMIPT0 yPrintshop

[] startJob [ Maximize Job Wiew
=< Back Next ==

+ Job number: HD0002
+ Job Name: HDO00O2_Auto_DD
- Job Group: MyPrintshop (is set by default)

- The "Start Job" option is disabled. Click "Next".

54

&

Scheduling

[ automatic

Browse...
Change...

Change...

Cancel

HZIDELB=RG
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3 Create new lab >

Customer ID:

Mickname:

Customer Joh 1D: HDO0o02

Customer Job Mame: [HDOOO2_Auto_DD

<< Back Next >>

3. Select "HD Printshop" as the customer in the "Customer Data" view. Then click "Next".

3 Create new lob *
b—8——— 08—

Basic job data Customer Data Processing Scheduling

You can assign seguence templates or group templates to the joh.

@ HDCity_Group_Templlate

Remowve

4. Inthe "Processing” view, "HDCity_Group_Template" is already set by default because we added
this group sequence template with the "Save as default" option to the manually created job (see
chapter "Manual Creation of a Print Job"). If you wish to add other sequences to the job, you can
do this by using "Add". You can remove existing sequences from the job by marking them and
clicking "Remove”.

5. No scheduling data will be entered because the job is being set up for automated printing. For
that reason, we will skip "Scheduling". Click "Finish".

The job is created and opens.
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6. Double-click the caption bar of the "Job" window to maximize the width of the window. All the
job settings and the "Documents” and "Pages" steps remain unchanged because different doc-
uments with the same settings will be output in an automated workflow. Go directly to the "Dig-
ital Printing" step (click this icon in the workflow bar).

All the required output settings are already configured because the "HDCity_Group_Template"
contains the preset "PagePrint_HDCity" sequence.

' Job

Name: HD0002_Auto_DD  Number: HD0O002 Custon

Calors

Close Joh

7. Leave the settings as they are. You will find more details about the "Digital Printing" step in the
section "Set up and output digital printing", page 42 or in the Online Help of the Cockpit (F1 key).

8. Start the job by clicking the start button (1).

9. This concludes your preparations for the automatic job. Close the job with "Close Job". All set-
tings are saved automatically.
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Automated Output of Documents

1. Open the Cockpit and view the job list in "Jobs".

2. If necessary, open the job group (in our example, "MyPrintshop") that contains the prepared job
and make sure that the "HD0002" job can be seen.

Joh Name < |JobStatus | Joh|m

New Job...

We will use the "HDCity.PDF" document again as the example document.

3. Open a Windows Explorer window (or a Macintosh Finder one) and go to the folder which holds
the PDF file to be output. This folder must be located on a local drive, data media or on a shared
network drive of the Cockpit computer.

HEIDELBERG

Drag-and-drop documeis
to this area or use the

function "Add Files".

Prinect DFE - User’s Guide 57



Automatic Creation and Output of New Jobs using Drag-and-Drop

4. Select the PDF file(s) and drag them, holding down the left mouse button, to the print job entry
and let go of the mouse button. The job then opens automatically and displays in the "Job" win-
dow.

5. To print the print job, maximize the width of the "Job" window (double-click the caption bar) and
go to the "Documents” step. Wait until the documents are processed and then go to the "Digital
Printing" step.

HSIDELB=RG

FBO01 Back

(6). If required, you can customize your settings in this step (see section "Set up and output digital
printing", page 42).

7. Click "Submit" (1). The "Submit Elements" dialog opens:
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¥ Submit X

Ourtpurt
{(® Mormal
y quantity | 5000
O TestPrint
1 y

Print Range

@® Al O Pages O Shests

Priority | Mormal =
»  Output Options
» Details

»  Scheduling

8. In this dialog, you can still assign a priority, correct the delivery quantity, assign a work type,
enter a comment and set the time for printing.

9. The print job is output to the press when you confirm this dialog with "OK".
10. After output, close the print job.

Output Other Documents

Repeat steps 1 thru 10 to output other documents automatically.
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Create New Print Jobs by Copying PDF Files to a
Hotfolder

With Prinect DFE you can set up a print job in such a way that new print jobs are automatically cre-
ated when documents are filed in a folder that is set up as a "hotfolder". In this chapter we will set
up such a print job and describe how to create new jobs.

Prerequisites for the Hotfolder Mode

For this workflow, some prerequisites must be met on the Prinect DFE computer so that automated
job processing works smoothly.

. Prerequisite: The following requirements must be met for output with a reusable print job:

- A hotfolder job template must have been set up in "Administration > Hotfolder". This job
template must have all the required settings (sequences, imposition and finishing
parameters) in a suitable form.

- An "external hotfolder location" must have been defined to be able to set up a hotfolder
job template. For a Prinect DFE setup, the "\PTJobs\External-Hotfolder" folder is
installed by default. Open "System" in "Administration" if you want to change this set-
ting. In the tree structure, mark "System", the topmost item (if necessary, you must click
"Hide Clusters"), and then click "Browse..." in "External Hotfolders Location" on the
right. In the dialog that then displays, you can select a different folder or create a new
one. You can also define an "External Hotfolders Location" on a different computer to the
Prinect server. You can find more details about creating an external hotfolder location in
the Online Help for the Prinect Cockpit in "Administration - System". In our example, we
will leave the default "\PTJobs\External-Hotfolder" as it is.

- The sequences required must have been assigned to the job template, either separately
or as a group sequence. This ensures the automated processing of printing.
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- The documents to be output must be able to be edited without an error and their page
size must match the imposition settings in the PagePrint sequence. The number of pages
does not have to match the page total defined originally in the PagePrint sequence. It will
be matched automatically during output.

Disable Preview Handler in Windows Explorer

The Windows Preview Handler is responsible for displaying previews of the different file types in a
Windows Explorer window.

Problem: A Prinect hotfolder can no longer be polled correctly if the Preview Handler needs more
than six seconds to calculate a preview. As a result, the PDF documents are not processed.

1.

Open a Windows Explorer window and invoke the "Folder Options" dialog (either with "Tools >
Folder Options" if the menu bar displays or with "Organize > Folder and Search Options" or with
"View" > Options > Change folder and search options") (Windows 8.1/Windows 10/Windows
Server 2012 R2/Windows Server 2016):

[ || = | EAPTDocs\Testjobs\HDCity\PDF - m] X
Hame Share (]
E [TH Freview pane = Bdtra large icons (& Larae icons 2 Medium icons [ Group by ~ [ item check baxes ] D
F smal icons B List == Detalls ] #ctet cotumns = File hame extensions Wi
Navigation - 2= . sort Hide selected  |Options
190N MEbetalispane = g EE content T by fiFSize all columns to fit Hidden items Biames p.
Fanes Layout Current wiew Showrhide [E Changefumeranusearmgptmns}
« v > ThisPC » E_DATA(E) » PTDocs » Testiobs » HDCity » PDF w|@ | Search PDF »

wwwwwwwww A ke [T

2. Open the "View" tab and disable "Show preview handlers in preview pane".

62

Folder Options *

General Yiew  Search

Folder viewss

Yo can apply thiz view [zuch az Details or lconz] to
all falders of thiz type.

Apply to Folders Reset Folders

Advanced zettings:

[ Launch falder windows in a separate process ~
[ Restore previous folder windows at logan
Show drive letters

[ Show sunc provider natifications
[ Usze check boxes to select items
[ Usze Sharing Wizard [Fecommended)
When tping into list view
() Automatically type inta the Search Box W

Restore Defaults

K Cancel Apply
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3. Confirm the dialog with "OK".

Prepare a Print Job
We will use the "HDCity.pdf" booklet print job as our basis, like in chapter "Manual Creation of a Print

Job", page 33.

Set up a Qualify sequence for the hotfolder mode

HEIDELB=RG

Open the "Qualify" sequence folder and highlight "Qualify_HDCity" (1). Click "Open" (2).

The setup section for the "Qualify_HDCity" sequence opens:

1.
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Set this sequence as follows:

2. Leave "Normalizing", "Split Document”, "Preflight" and "Destination" as they are.

3. Enable "Hotfolder" and set the following parameters:

a. In the "Hotfolder" box (1) leave the "$Template" setting as it is. This setting makes sure
that the file names of the job documents are used for the names of the new jobs.

b. Enable the "in External hotfolder location" option (2). With this option, the new jobs are
stored in the set hotfolder location on the Prinect server.

c. In "Insert into external hotfolder path" (3), leave "Job number" as it is. By doing this, a
separate subfolder with the job number as the folder name is created for each job.

d. Enable "Create new job and process document there" (4). When this option is enabled,
new jobs are created automatically when document files are filed in the hotfolder.

e. In the "Job group for new job" list box (5) leave "Current job group" set. The new jobs
generated are created in the same job group as the original job.

f. Set "Create and use job with a new job number" in the "When job number already exists"
list box (6). Based on the job number determined, a new job number is created by
appending an index. After that, a new job is created with this job number.

You can use "The file name contains" to determine detection rules for interpreting the
file names of the PDF files you want to process by detecting and using certain parts of
the file name as job parameters. You will find more details about these detection rules
in the Cockpit Online Help in the "Sequence Templates" section in "Preparation > "Qua-
lify" Sequence Template > Hotfolder" option.

We will use a simple example and generate only the job number and job name from the
file names.

g. To do this, select "the job number" in the "in position 1" list box (7). Check the "from first
character" option (8) and enter the character "#" in the "up to delimiter" box (9). As a
result, the file name of the filed documents is interpreted in such as way that all charac-
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ters before the "#" in the file name are identified as a job number and are used for the
new jobs. The file names of the filed documents must have this delimiter and appropriate
characters for the job number in order for new jobs to have a job number.

h. Then select "the job name" in the "in position 2" list box (10). The "from first character"
option remains disabled. Enter the character "&" into the "up to delimiter" box (11). This
character acts as a rear limitation for the job name. All characters between these two
delimiters in the file name of the filed documents are used as the job name.

Example: A document named "1234#Brochure_HD&.pdf" creates a job with the number
"1234" and job name "Brochure_HD".

Caution: When you define job names, make sure that job names and job numbers in a Pri-
nect system are always unique. A new job will overwrite an existing job if the new job is cre-
ated in the hotfolder mode and its job name and job number match those of the existing job!

4. Leave the other steps as they are and click "Save as".

# Save Template *
] P

Template Mam

Comment:

Customer ID: oood

Frodu

Product Types:

New Folder...
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5. Enter "Qualify_AutoJob" as the name. Confirm the "Save Template" dialog with "OK".

6. Click "Close". The sequence overview displays.

Create a group template for automatic job creation

1. In "Administration > Templates", mark "Group Templates" in the sequence overview and click
"New".

The empty setup window of a group template opens.

File | Edt | View | Tools | Help |

E O fr HZIDSELB=RG

Add Template

2. Open the "Qualify" folder and select "Qualify_AutoJob" (1).
3. Then click "Add Template" (2).

An icon for the Qualify sequence is created in the workspace.
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4. Repeat steps 2 and 3 also for the "PagePrint_HDCity" sequence. The workspace now displays as
follows:

PagePrint_HDCity

Add Template

5. In the workspace, select "AutoArrange" in the context-sensitive menu. The icons are placed side
by side and aligned.

6. Save the group template as "AutoJob_Group_Template" using "Save as".

7. Close the view by clicking "Close". Then click "Overview".

Automatic creation of print jobs

After the Qualify sequence is configured, a new print job template is now created in "Administration
> Hotfolder" that is used for automatic job creation. Hotfolder job templates do not display in the job
list so that they are not inadvertently deleted. Administration of these templates is solely in "Admini-
stration > Hotfolder".

A PagePrint sequence is needed in addition to the Qualify sequence. For this purpose, you add the
"PagePrint_HDCity" sequence that you already created to the new job (see the section "Configure a
PagePrint Sequence", page 22).

Create a hotfolder job template

1. If not already there, go to "Administration” and click the hotfolder icon.
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Settings

¥ B B B

System Preferences Customers

File | Edit | View | Tools | Help |

B 0 &

Overview

Set up the job template as follows:

2. Enter "MyAutoHF" as the name.

Administration

% |y

E-mail Hotfolder

HEIDELB=RG

3. Leave "with current date" enabled in "Job group for new job". This setting generates a separate
job group with the current date as the group name for all the jobs created on this day.

4. Click "Import" in "Processing”. Select "AutoJob_Group_Template" in the "Select Templates to

Add" dialog.

68
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'3:'{', Select Templates to Add x

Confirm with "OK".

5. Click "Save".

The new job template, "MyAutoHF", displays on the left of the window. You can create other job
templates with "New", if required. We now close the view by clicking "Overview". The hotfolder
job template is now set up.
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Create a New Job by Filing to the Hotfolder

After you prepared the job template for automatic job creation in the hotfolder mode, job processing
can begin.

Prepare Document File Names

Delimiters were defined in the hotfolder settings of the Qualify sequence and they can be used to fil-
ter out the job number and job name from the document file names. We will customize the file names
of the PDF documents to be output so that we have useful job numbers and job names.

Caution: When you define job names, make sure that job names and job numbers in a Pri-
A nect system are always unique. A new job will overwrite an existing job if the new job is cre-
ated in the hotfolder mode and its job name and job number match those of the existing job!

We will use the "HDCity.PDF" document again as the example document (see section "Automated
Output of Documents", page 57).

Create and Start a Print Job

1. We will create a new folder named "PTDocs\Testjobs\HDCity_AutoJob" and copy "HD_City.pdf"
to this folder. The file will be renamed to "GS0010#HDCityA4&P01_P36.pdf". Based on the set
delimiters "#" and "&", a new job with job number "GS0010" and job name "HDCityA4" will be
produced.

To output "GSO0010#HDCityA4&P01_P36.pdf", you will now copy it to the hotfolder of the
"HMyAutoHF" template job:

2. Inthe Windows file system, mark the file and select "Copy" in the context-sensitive menu.
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Go to the hotfolder of the "MyAutoHF" job. You will find this folder on the Prinect server in the

"PTJobs" folder and there in "ExternalHotfolder\MyAutoHF".

ate a new print job.

Select "Insert" in the context-sensitive menu. By inserting the PDF file, you automatically gener-
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5. In the Cockpit, go to "Jobs" and there to the job list. After a brief period, a new group with the
current date displays below "PRJOBS". This group contains the new job "GS0010".

Fle | Edit | View | Job | Tools | Help |

G 8 & HEIDELBERG

{j¢ I  Job
. Name: HDCityA4 Number: GS0010

%+ Job Status S/ Job g
Digital Printing
7

This job starts, is processed and can be output automatically.

6. To output the print job, wait until the documents are processed and then go to the "Digital Print-
ing" step.

(7). If required, you can customize your settings in this step (see section "Set up and output digital
printing", page 42).
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ame: HDCityA4  Number: GS0010

Elements +  Sequence + | Status

8. Click "Submit" (1). The "Submit Elements" dialog opens:

3 Submit *

Outpurt

Marmal

De ¥ quantity | 5000
() TestPrint

1

Print Range

Priority | Mormal =
¥ Output Options
» Details

¥ Scheduling

Cancel

(>)

% (P 3 /-] () £7
Colors Documents Pages Digital Printing
e e

%+ | Recent Message

in the Hotfolder Mode

P ldie

Non-printing Marg

(]

E B Imposition Trimmed Size

E » Bleed and Trim Allowance

1
Color Matching.... Submit...

% | Modification Date

e L]

> L

T

History

Close Job

=]

9. In this dialog, you can finish off, for example, by running a test print (1), assigning a priority, cor-

recting the delivery quantity and/or entering a comment.

10. The print job is output to the press when you confirm this dialog with "OK".
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11. After output, close the print job.

Output Other Documents

Repeat steps 1 thru 10 to output other documents automatically.
Caution: When the "master job" stops, the related hotfolders will also be deleted! For that
reason, make sure that the condition of the master job is always "ldle".

In this way, you can automatically generate more print jobs.
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